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Lesson Objectives 

 Learn how to edit the company Chart of Accounts 

 Learn how to add a new customer to the Customers & Jobs list 

 Learn how to add a new vendor to the Vendor list 

 Learn how to manage lists in QuickBooks 
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Working in QuickBooks Lists 

QuickBooks lists organize a wide variety of information including data on customers, vendors, inventory items and more. 
Lists save you time by helping you enter information consistently and correctly. Information that can be stored in lists are 
items like: 

 Names, addresses and other information about customers 

 Contact information for vendors 

 Descriptions and prices for products and services 

 Account information  

 

 

 NOTES
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Editing the Chart of Accounts 

The Chart of Accounts is your most important list because every transaction recorded in QuickBooks affects an account 
from your chart of accounts. The Chart of Accounts are the foundation of your financial reporting. It is used to create 
important reports like the Profit & Loss and Balance Sheet report.  

To display the chart of accounts: 

 From the Lists menu choose Chart of Accounts or press CTRL+A 

 

 Scroll through the list.  

The Chart of Accounts displays balance sheet accounts first, followed by income and expense accounts by default. 
Optionally, you can click on the column headings to sort by name or balance instead of type.  

 

 NOTES
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Editing an Account 

To edit an account: 

 In the Chart of Accounts find the account you want to edit then click on it one time to highlight the row. 

 Right-click on the row and click Edit or click the Account menu button then select Edit Account. 

 Edit the information accordingly. 

 

 Click Save & Close. 

NOTE: Some information, like Account Type, is not easily changed. If you setup an account in error and you are trying to modify 
it you can delete the account and start over, assuming no transactions have been posted to it. 

 NOTES

 



Lesson 3 — Working with Lists Adding a Subaccount 

QuickBooks 2018 Student Guide 9 

Adding a Subaccount 

A sub-account is a way of breaking an account down in to sub-categories for reporting purposes, to make a large account 
more manageable or to group related expenses together for your reports, it's useful to set up subaccounts. Another way to 
think of this is that you are breaking down general expenses into greater detail. 

In QuickBooks, the more general category of expenses is called a "parent account." The more detailed categories that are 
grouped under the parent account are called subaccounts. Subaccounts let you track several related types of income or 
expenses independently yet keep them all under the "umbrella" of a single parent account. 

For example, if your business has substantial advertising expenses, you might decide to divide your Advertising expense 
account into several subaccounts, such as Newspaper Ads, Signs, Yellow Pages Listing, and Direct Mailings. Your chart of 
accounts displays these accounts in the following manner: 

Advertising 

   Direct Mailings 

   Newspaper Ads 

   Signs 

   Yellow Pages Listing 

Your reports will now show subtotals for the various ways that you advertise, as well as the total for all of your advertising. 

In your chart of accounts, each subaccount appears indented immediately below its parent account. If the subaccount is a 
balance sheet account, QuickBooks includes its balance in the balance of the parent account. When you open the register 
of the parent account, the register shows all the transactions in the subaccounts. 
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To add a subaccount: 

 In the Chart of Accounts click the Account menu button and then choose New. 

 Select the appropriate account type (this must be the same account type as the parent account). 

 Click Continue. 

 Assign an appropriate account name and number if applicable. 

 Select the Subaccount of checkbox then select whichever account you would like to be the parent account from the 
drop-down list. 

 

 Click Save & Close. 
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QuickBooks displays the new subaccount in the Chart of Accounts list. 

 

 Close the Chart of Accounts. 

 

 

 NOTES
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Customer and Vendor Centres  

The Customer and Vendor Centres consolidate and organize important information. The centres contain names, addresses 
and other information about these lists. They also hold more specific information, Contacts, Notes, To Do’s and Sent 
Emails, custom fields and other details you may want to track for each customer and vendor.  
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Custom Contact Fields 

The Customer and Vendor includes include eight fields for custom contact information. All eight of these contact fields for 
phone numbers, email addresses and URL’s can be customized per the drop-down list of available contact descriptions 
(mobile phones, social media information, etc.). 

 

 NOTES
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Working with the Customers & Jobs List 

The Customer Centre stores names, addresses and other information about your customers. It also holds information 
about the jobs or projects you may want to track for each customer. 

 

Adding Customers 

Your customer list is the list that will display information on sales forms (i.e., sales orders, estimates, invoices, sales 
receipts). 

To add a customer: 

 There are multiple ways to do almost anything in QuickBooks. To access the Customer Centre, you have four options: 

 Click Customers from the left hand or top icon bar (depending on your view settings) 

 Choose Customer Centre from the Customers drop-down menu 

 From the Home screen click on the blue Customers tab in the customers section 

 Press CTRL+J 

 Click the New Customer & Job menu button then choose New Customer. 

 In the Customer Name field enter the name of the customer as you'd like it to appear on your Customers & Jobs list.  

 Press Tab in the Opening Balance field to leave this field blank. 

 The Opening Balance field tells you how much each customer owes you on your start date so that when you enter the 
rest of your transactions from your start date to today, all balances since your start date will be accurate. 

It is generally recommended entering outstanding invoices one by one whenever possible. 

  Complete the customer contact information appropriately. 
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You can have and use more than one Ship To address per customer or job. Add them with the Ship to drop-down or by 
clicking the + sign in the bottom right corner. 

 

 Click OK to add this customer. 

The Customer Centre appears with the Customers & Jobs list along the left side.  

NOTE: The Customers & Jobs list is the same list as the Customer/Job list. It is called Customers & Jobs on the Customer Centre, 
and it is called Customer/Job on forms. It is sometimes also referred to as simply the Customer list. 

 NOTES
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Sales Tax Settings 

If you have regular customers with special tax status, such as exempt from sales tax, you can assign them their own sales 
tax codes. Similarly, you can also assign a sales tax code to a vendor. For example: You sell T-shirts that are taxed 
normally, and you have assigned them the "S" (standard) sales tax code in your Item list.  

However, you sell to a government office that is exempt from paying GST/HST. In the customer's information, you can 
assign the "E" (Tax Exempt) customer code, which then overrides the T-shirts' "S" code on all sales forms, such as invoices, 
estimates, and sales receipts.  

NOTE: Customer and vendor sales tax codes override all item codes (including non-taxable ones) on all transaction forms, 
so use caution when assigning sales tax codes to customers. 

To add a customer tax code: 

1. In the Customer record, click Sales Tax Settings. 

2. Choose the customer Tax Code. 

 

 NOTES 
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The Payment Settings tab is where you enter customer account numbers and credit limits. You can also record information 
about each customer’s preferred payment method. For customers who pay by credit card, you can enter credit card 
numbers and expiration dates. 

 

 NOTES
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Working with the Vendor Centre 

The Vendor Centre is the place where you record information about the companies or people from whom you buy goods or 
services.  

Adding Vendors 

In order to pay your bills with QuickBooks you need to add your vendors. Nearly everyone you pay, other than employees, 
is a vendor. Your vendor list supplies the names available on purchase forms like purchase orders, vendor credits, sales tax 
payments, payroll tax payments and bills. 

To add a vendor: 

 Just like the Customer Centre, there are multiple ways to access the Vendor Centre in QuickBooks: 

 Click on Vendors from the left side or top icon bar (depending on your preference 

 From the Vendors drop-down, click Vendor Centre 

 From the Home screen click on the Vendors tab in the Vendor section 

 Click the New Vendor button then choose New Vendor. 

 In the Vendor Name field enter the name of the vendor as you'd like it to appear on your Vendor list.  
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 Enter the remaining vendor information appropriately. 

 Click OK to add this vendor. 

 

The new vendor appears on the Vendor list. 

 



Lesson 3 — Working with Lists Managing Lists 

QuickBooks 2018 Student Guide 20 

Managing Lists 

Sometimes you may want to re-order the way that your accounts appear in the different sections of your financial reports. 
You can re-order each section of your Chart of Accounts (within its account type) by following the instructions below. 

To sort a list manually: 

 From the Lists menu choose Chart of Accounts. Scroll to the account you would like to move.  

 Click the diamond to the left of the account name.   

 Click and hold the mouse button and drag the pointer upward until you see a dotted line directly below the account 
name. 
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 Release the left mouse button to drop the account in the new position. 

 

 To re-sort the list alphabetically click the Account menu button in the bottom left corner of the Chart of Accounts 
screen and select Re-sort List. 

 Click OK. 

 Close the Chart of Accounts. 

You can sort lists in QuickBooks by clicking on column headers like the Name and Balance Total. The example below uses 
the Customer Centre, but this also applies in the Vendor Centre, Item list and Chart of Accounts. 

To sort a list in descending order: 

 Click Customers on the icon bar to display the Customer Centre and Customers & Jobs list. 

 Click the arrow to the right of the View drop-down list to expand the Customers & Jobs list. 
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 Click the Balance Total column heading. 

 Click the column heading again. 

 To return to the order you started with, click the large diamond to the left of the Name column heading. 

 Click the collapse arrow to the right of the window to collapse the Customers & Jobs list. 

 Close the Customer Centre. 

 

 

 NOTES 
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In most lists you can combine two list names into one. For example, you may find that you’ve been using two customers 
(because of different spellings) when you really need only one on your Customers & Jobs list. You can merge list items in 
the Chart of Accounts, Item, Customers & Jobs, Vendor, Employee and Other Names lists. This example uses the Vendor 
list, but the concept is the same regardless of list type. 

To merge items on a list: 

 From the Vendors menu choose Vendor Centre. 

 Double-click the entry you wish to merge (this entry will be merged into the other entry). 

 

 In the Vendor Name field change the name to exactly match the name of the record you wish to merge with. 

 Click OK. 

 You will get a warning dialogue telling you there is another record with this name and asking if you would like to 
merge. Click Yes. 

 Close the Vendor Centre. 

NOTE: You cannot merge two names from different lists such as a Vendor and Customer record or Other Names list record. 
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To rename a list item: 

You can rename any list item. When you make the change QuickBooks automatically modifies all existing transactions 
containing the item. This example demonstrates renaming in the Chart of Accounts. 

To rename a list item in the Chart of Accounts: 

 From the Lists menu choose Chart of Accounts to display the Chart of Accounts. 

 In the Chart of Accounts select the account you would like to rename. 

 Right-click on the account and click Edit Account or click the Account menu button and choose Edit Account. 

 Make your changes in the Account Name field. 

 Click Save & Close. 

 Close the Chart of Accounts. 

 NOTES 
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You can delete list items if you have not used them in any transactions. If you try to delete a list item that is used in a 
transaction QuickBooks displays a warning that the item can’t be deleted. If you don’t want to use a list item but you can’t 
delete it, you can make it inactive. Here is an example from the customer Centre. 

To make a list item inactive: 

 Navigate to the Customer Centre (from icon bar, drop-down or home screen). 

 Select the Customer/Job from the list that you wish to make inactive. 

 Right-click the name and choose Make Customer/Job Inactive. 

 To see inactive list items, choose All Customers from the View drop-down list. 

 

 NOTES
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Printing a List 

You can print a QuickBooks list for reference or you may print a list to a file to use in your word processor or spreadsheet. 
QuickBooks prints the Customers & Jobs list as it appears on the screen. For example, if the Customers & Jobs list is 
expanded and sorted by balance total, QuickBooks prints the expanded list sorted by balance total. If the list is collapsed, 
QuickBooks prints just the customer name, the balance total and active status. 

To print the Customers & Jobs list: 

 In the Customer Centre click the Print menu button then choose Customer & Job List. 

 Click OK to bypass the List Reports message. 

 Click Print. 

 

To print information on one customer: 

 In the Customers & Jobs list select the customer whose details you want to print. 

 Click the Print menu button then choose Customer & Job Information. 

 Click Print. 

If you want to print information for selected customers only, you can generate and filter the Customer Contact report for 
those customers. You can also modify the report to include the columns that you want. 
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To print information for selected customers: 

 From the Reports menu choose List then choose Customer Contact List from the submenu. 

 Click Customize Report. 

 Click the Filters tab. 

 Select Customer in the Filter list. 

 In the Customer field choose Multiple customers/jobs. 

 Make sure Manual is selected then click to put a checkmark next to those customers for whom you want to print 
contact information. 

 Click OK to close the Select Customer/Job window. 

 Click OK to close the Customize Report window. 

 Print the report. 

 Close the Report window. 

 Close the Customer Centre. 

 NOTES
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Adding or Editing Multiple Items at One Time 

If you have existing information in Microsoft Excel® you want to add to QuickBooks or if you want to make changes to 
multiple items, you can do so for items in the following lists: Customers, Vendors, Service Items and Non-inventory Parts. 
(Multiple items may also be added to or edited in the list of Inventory Parts, if the inventory preference is turned on.) 

To edit multiple list items at once: 

 Go to the Lists menu and choose Add/Edit Multiple List Entries. 

 Choose the list you would like to edit from the List drop-down. 

 Use the Customize Columns button to customize the information you would like to see. 

 

 Use the Find field if needed.  

 Utilize copying tools by right-clicking in a cell on the grid. 

 When your changes are complete click Save Changes. 

 Close. 

 NOTES
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Review Activities 

 From the File menu in QuickBooks, choose Open or Restore Company. QuickBooks displays the Open or Restore 
Company window.  

 Select Restore a backup copy and click Next.  

 Select Local backup and click Next.  

 In the Open Backup Copy window, navigate to the appropriate directory.  

 Select the qblesson.qbb file, and then click Open.  

 In the Open or Restore Company window, click Next.  

 Navigate to your directory.  

 In the File Name field of the Save Company File As window, type Lesson3 and then click Save.  

 Enter the Password: QBDT2018! 

 Click OK when you see the message that the file has been successfully restored. 

 

 Add the following customer using the data below: 

o Customer Name: Alla Rozenvasser 
o Opening Balance: $234.00 
o Company Name: Rozenvasser Advertising 
o Contact: Alla Rozenvasser 
o Bill to: 300 Main Street, Suite #3, Toronto, ON. 
o Phone: 647-555-6767 
o Fax: 415-555-9090 
o Alt. Contact: Shannon Stubo 
o Type: Commercial 
o Credit Limit: $2500 
o Terms: Net 15 

 Add a new vendor using the data below: 

o Vendor: Martin Drywall 
o Contact: Sean D. Martin 
o Address: P.O. Box 76, Ottawa, ON. 
o Phone:647- 555-5432 
o Fax: 647-555-6565 
o Type: Subcontractors 
o Terms: Net 30 
o Credit Limit: 1,000.00 

 Create an expense subaccount under Professional Fees called Consulting Services. 

 Create an expense account to named Telephone.  Merge the account into the Telephone Expense account.  

 


